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Introduction and Connection 

Introduction 

Landt Battery Test Systems are designed for the test of a variety of primary and secondary 

batteries such as lithium-ion, nickel-metal hydride and nickel-cadmium batteries, from 

coin-cell batteries (0.001mA) to electric vehicle batteries (500A). The battery testers 

support battery tests in most cases, including materials research, battery life test, electric 

vehicle battery test. Our battery testers have been widely recognized by industrial battery 

manufacturers and university research groups for the high precision, high reliability and 

friendly interface. 

The test system has the following features. 

 Each test system provides 1 - 8 independent channels.  

Landt CT2001 series battery test system comes with 1-8 independence channels. Several 

testing station can be connected and controlled by one computer at the same time. LANDT 

Battery Testing systems allow up to 10 testing devices (80 channels) to be controlled 

through one RS232/RS422 communication port in a computer. Each channel can be 

individually programmed to be constant-current charge and discharge, constant-voltage 

charge and constant-power discharge, constant-resistance discharge, OCV test (rest) etc.  

 Easy programming 

The LANDT Battery Testing systems come with a very friendly interface (Landt Monitor 

software) which allows users to start using it with little training, while the test procedure 

could be programmed to conduct complicated test. 

1. It allows unlimited testing steps (more than 800) in a test; 

2. The exit condition can be set by time, voltage, current, or a combination; 
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3. It supports self-defined Variables for very complicated cycle test. 

 Controllability 

Users can do "Jump (GOTO)"or modify the testing parameters during the test. Also it 

allows the stopped channels to get resumed (data monitor continues).  

 "Relocate Channel" function 

When the cell is moved from one channel to another, the testing can be resumed with data 

collection continued.  

 Support the auxiliary test channel  

While users are doing the regular charge/discharge testing, auxiliary test channel can be 

used to test temperature, pressure, single cell voltage at the same time. This greatly expands 

the test capability. 

 Effective data backup  

The software supports automatic data backup during the test.  

 Powerful data processing capability 

The Landt Data Processing software is small but powerful. The detail will be discussed. 

 Reliable and efficient connection 

The software can control many Landt battery testers at the same time. Each test device 

has two serial ports which allow all the boxes to be connected one by one. The last device 

is connected to the serial port interface of the computer. 
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Hardware Connection 

The front and rear panel 

 

(Figure 0-1) 

 

 

① Power Switch 

② Power Status Indicator 

③ Channel Status Indicator 

④ Channel Connection 

⑤ Station Number 

⑥ Power Plug-in 

⑦ Data and Control 

Connection (RS422/RS232) 

⑧ Data and Control 

Connection (Same as ⑦) 

 

Channel connection 

 

(Figure 0-2) 

 

 

① Connect to positive electrode, Voltage measurement; 

② Connect to positive electrode, Current path; 

③ Connect to negative electrode, Current path; 

④ Connect to negative electrode, Voltage measurement. 

Alligator clips 

Each set of the alligator clips contain four clips: big red clip, big black clip, small red 

clip and small black clip. Please note: 
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Red clips connect to positive electrode of the battery; 

Black clips connect to negative electrode, 

with 

Big clips to supply/monitor the current; 

Small clips supply/monitor the cell voltage.  

 

For connection of three-electrode test the big red clip connects to positive electrode of 

the cell while big black one connects to the negative since the big alligator clips help 

forming the current loop. Small red clip and small black clip are to measure the cell voltage, 

so they should be connected to the working electrode and reference electrode respectively.  

 

Figure 0-3 
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Connect to the computer 

 

Landt Battery Testing systems use RS232/RS422 serial port (9-pin port) to 

communicate with the computer. To make the connection, use the communication cable 

(provided with the test system) to connect the RS422 port on the back of the test machine 

(Figure 1-1 ⑦ or ⑧) to a serial port on the desktop computer. If there are several tester 

units, use the other RS422 port (⑦or ⑧) connecting the next unit and thus all the units 

can be connected in series. The computer automatically searches for all the tester units. 

If a PCI-e to serial port adapter card is installed on the computer, make sure the driver 

is also updated. The user can also use a USB to RS232 serial port converter. It is strongly 

suggested using a serial port on the desktop since the communication is more reliable.  

 

Software Introduction and Installation 

The Landt Battery Testing system software includes four parts, Landt Monitor 

Software (LANDMon), Landt Testing Steps Editor software (LANDProc), Landt Data 

Processing Software (LANDdt) and Landt Calibration Tool Software (LANDCali). The 

latest software can be downloaded from manufacturer’s website.  
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Landt Monitor Software (LANDMon) 

It is assumed that the users are familiar with Windows operation system and the use 

of the mouse and keyboard. In the following "left click" means click the left button of the 

mouse, and "right click" click the right button of the mouse. 

Start the software 

Before starting the software, the battery testers should be plugged in with power supply 

and switched on. Make sure all testers are connected in series and connected with the 

computer via serial ports.  

Double click the shortcut icon "LANDMon" to start the Data Monitor Software. 

"LANDMon" starts with the interface shown below. If 8 channels are shown in the window, 

the connection is successful. 001, 002 and 003 etc. indicate different device boxes. In the 

following figure there are four boxes (32 channels) connected to a computer. 

 

Figure 0-1 

If the power was not turned on before starting software, or the communication port was not 

connected to the computer serial port, you can set them down and then select menu 

"Network">"Connect" to re-start the automatic connection process. 
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Software features overview: 

The software for Landt Battery Testing systems have the following features. Most of them 

can be achieved by right click the channel.  

1) Automatic test. The test is fully automatic and controlled by the computer. Before the 

test working steps needs to be scheduled. A schedule normally contains many steps 

and sometimes cycle loops. 

2) Real-time monitor. It displays charge and discharge status (including voltage, current, 

capacity, number of cycles, etc.) during the test. 

3) Channel start. Every channel is independently controlled. So they have to be scheduled 

and started manually, although the schedule can be saved and re-loaded, and several 

channels can be started at the same time if they use the same schedule.  

4) Channel stop. A channel automatically stops after completion of all the steps. At the 

same time, the software also allows the user to stop it manually.  

5) Jump. During the test the user can manually suspend the current step and jump to a 

specific step. 

6) Setup parameters modification. Parameters in the schedule can be modified during the 

test.  

7) Channel resume. After stop the channels can be resumed and data sampling will 

continue. It will follow the schedule which was programmed last time.  

8) Active materials loading. The active loading is used to calculate specific capacity.  

9) Real-time monitor of the data. The data can be opened at any time during the test.   

Start a test 

Landt battery tester allows users to set unlimited steps in a single test in each channel. 

In each step it can be set as CCC (Constant Current Charge), CVC (Constant Voltage 

Charge), CCD (Constant Current Discharge), Rest, DCIR and so on. In addition, Loop and 

Decision can be used to implement cycle or specific jumps. The user can also set self-

defined Variables to set up the cycles. All these operations will be fully discussed, however, 

new users are strongly recommended to use the guide to set up the test. 
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Start a cycling test with the guide 

Open the Landt Monitor window, chose the menu "Test">"Start a Test", you’ll see the 

test table (Figure 0-2). The table shows the previously-used test schedules in the list in case 

the user wants to use or modify one of them. Choose "New" to set up a new test in the new 

window. 

 

Figure 0-2 

Users can also right click the channel and select "Start". Click the test name to schedule 

a program. In the dialog box data backup plan can be scheduled. We can set the backup 

directory and the name of the test data. The name is set as "AB_C.cex" where for example 

B stands for the unit number (box number), C is the channel number. If A is not checked 

the data will be saved as for example "_001_2", which stands for Channel 2 in unit 001. 
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Figure 0-3 

Click on the testing name (Figure 2-3), or double click the "LANDProc" icon on the 

computer desktop----You can start the Testing Steps Editor software (LANDProc.exe). 

Complete the step editing settings in the Testing Steps Editor software 

(LANDProc.exe). After the setup is done right click the channel and select "Start" to start 

the test.  
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Landt Testing Steps Editor software (LANDProc) 

In this section, the parameters in the Testing Steps Editor software are introduced. 

 
 

Figure 3-1 

The software uses flow chart to edit working steps. For simple tests, the writing of 

flow chart is simple and clear. Using the software to write test steps, it can be understood 

almost at a glance, even without reading the other document. 

As can be seen from Figure 3-1, the main interface of the software (LANDProc.exe) 

consists of menu bar, working step object bar, common toolbar, status bar and editing area, 

while the editing area includes three parts: flow chart editing area, test name and global 

configuration. 
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Classification of testing steps (working mode) 

The default Testing Steps Editor software includes CCC, CCD, CVC, CC-Rate, DCIR, 

Rest, Loop and Decision, Pause and so on. Users can also add other working steps that 

need to be enabled by choosing the main menu command "Options > Config Steps". 

Icon Meaning Type 

 Constant Current Charge 

Entity Steps 

 Constant Current Discharge 

 Constant Voltage Charge 

 Constant Voltage Discharge (not yet realized now) 

 Charge at constant current Rate 

 Discharge at constant current Rate 

 Constant Power Charge 

 Constant Power Discharge 

 Constant Resistant  Discharge 

 Rest 

 Direct Current Internal Resistance 

 Variables 

Non-entity Steps 

 Loop 

 Decision 

 Pause 

 Comment 

 

The testing steps can be divided into two groups: entity step and non-entity step.  

1) Entity step: refers to the step that can be directly assigned to the test channel as the 

charging, discharging or other working state. For example: Rest, CCC, CVC, CCD and so 

on. 

2) Non-entity step: the step that can’t be given to the test channel as a charge or 

discharge state is non-entity step. For example, Loop, Pause and Decision and so on. Non-

entity step usually plays the role of process control or as a specific program marker, which 
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enhances the performance of test programming and makes test programming simple and 

flexible. 

The first "testing step" is usually set to Rest, and the sampling voltage (or display 

voltage) is the open circuit voltage (OCV) of the battery under test. 

Configure testing steps 

Select the main menu command "Options > Config Steps" and pop up the " Config 

Steps" window (Figure3-2), where each work step bar currently has a selection flag (check 

button). When the selected flag is the selected state, the corresponding working step is 

enabled; otherwise, when the selected flag is unselected, the corresponding working step 

is not enabled. 

Users can select the testing steps to be enabled according to their needs, select "Hide 

disable steps" and click the "OK" button, then the working step selected by users will be 

displayed in the working step object bar, and the working step not enabled will be hidden 

(will not be displayed in the working step object bar). Through the settings of this window, 

users can add or hide working steps in the object bar at any time. 

 

Figure 3-2 
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Test Name Settings 

Double-click the "Unnamed" display box on the main interface of testing steps editor 

software, and pop up the test name "Parameters" setting window (Figure 3-3). The "Testing 

Name" can be set by the user. 

 

Figure 3-3 

Global Configuration Settings 

Double-click the "Global Configuration" display box in the main interface of Testing 

Steps Editor, and pop up the "Parameters" settings window of Global Configuration (Figure 

3-4). The "Global Configuration" includes detailed parameter settings of "Unit Scheme", 

"Voltage Safety", "Current Safety", "Capacity Safety" and "Change-trend Safety". 

Unit Scheme Settings: Click on the "Details" button on the right side of the Unit 

Scheme Settings Bar (Figure 3-4). It shows "Unit Scheme" Settings Window (Figure 3-5). 

At present, there are three unit schemes: "based on mA", "based on Ampere" and "based 

on uA". Users can choose according to the test requirements. At present, the software only 

supports changing the unit scheme for current, while the voltage unit is fixed at Volt. The 

corresponding capacity, power, resistance and other boxes will change according to the 

change of current unit.  
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Figure 3-4 

 

Figure 3-5 

Voltage Safety setting: As shown in Figure 3-4 above, one of the "Voltage Safety" 

is "overvoltage range protection", which means that when the voltage is measured, the 

measured value of the voltage reaches 101.5% of the rated voltage of the test battery (that 
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is, the measured value of the voltage). When the battery voltage exceeds 1.5% of the rated 

voltage, "Voltage Safety" will take effect and the test will stop. 

The last item in "Voltage Safety" is a time to set the voltage protection delay to take 

effect. This is mainly used in some cases when the battery is in the initial low-voltage state 

(for example, before the battery formation), and it takes a short charge to enter the normal 

voltage range. The "Voltage Safety" does not work at the beginning. It only takes effect 

when the battery enters the normal state. 

Current Safety setting: The last item in "Current Safety" is "super current range 

protection". It is mainly used for charging state. The measured value of current reaches 

101.5% of the rated current of the test battery (that is, the measured value of current exceeds 

1.5% of the rated current of the battery). Then "Current Safety" comes into effect and the 

test stops. 

Capacity Safety setting: When the capacity value accumulated by the battery 

exceeds the charging capacity setting value during continuous charging, or when the 

capacity value accumulated by the battery during continuous discharging is lower than the 

discharge capacity setting value, the test stops. 

Detailed settings for protection conditions (including "Voltage Safety", "Current 

Safety", and "Capacity Safety") are provided in the following sections. 

Property Edit Settings 

Click on the small settings button  on the right side of any Step Parameter window 

and enter the Property Editing Settings dialog box (Figure 3-6). 

In the "Prop Edit Set" interface, there are four kinds of attribute settings: "Input 

conditions", "Input confirm", "Independent safety protect for steps", and "Limit-parameters 

for steps". The "Input confirm" only involves the selection of confirmation shortcut keys, 

which is simple and easy to understand. There is no further explanation here. 
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Figure 3-6 

1. Input conditions 

When "Input conditions" chooses "The classical method", the mouse clicks the edit 

box of "End Conditions" and it comes the "Multi-Conditions Edit" dialog box (Figure 3-

7). As can be seen from the figure, the interface of "Multi-conditions edit" is similar to that 

of the old version of testing step editing. The function of "The classical method" is mainly 

to take into account the users’ habits of the old version software. 

 

Figure 3-7 

As shown in Figure 3-7, in the Multi-Conditions Edit window, the "+" or "-" keys are 

used to add or reduce conditions to form single or multiple conditions. 
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When "Input conditions" chooses "Text with syntax high lightening", the mouse clicks 

on the edit box of "End Conditions", then the user's set conditions will be highlighted in 

the form of yellow rectangular box above the edit box (Figure 3-8).      

 

Figure 3-8 

2. Independent safety protect for steps 

When the "Independent safety protect for steps" are selected as "Enable All" or 

"Enable, except Rest", the "Safety Conditions" edit box in the main interface of 

"parameters" will be available (Figure 3-9). Users can set different security protection 

conditions for each step according to the test requirements. The setting step and function 

of "Independent safety protect for steps" are consistent with the protection conditions of 

the working step. Please refer to the following chapters for details. 

 

Figure 3-9 

The "Safety Conditions" edit box will be disabled when the "Independent safety 

protect for steps" is selected as "Disable" (Figure 3-10). For the testing process, only the 

security parameters set in the "Global configuration" can play a protective role. 
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Figure 3-10 

3. Limit-Parameters for steps 

When "Limit-Parameters for steps" is selected as "Enable", the "Lmt-Para for steps" 

edit box in the main interface of "Prime Parameters" will be available (Figure3-11). 

Enable and set the "Limit Parameters" to play the role of current limiting protection for 

the current charging process. 

 

Figure 3-11 

When "Limit-Parameters for steps" is selected "Disable", the "Lmt-Para for steps" edit 

box in the main interface of "Prime Parameters" will be disabled, and the "Limit-

Parameters for steps" function is invalid(Figure3-12). 
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Figure 3-12 

Addition and deletion of testing steps 

Adding a step: directly click on the step object, and drag it to the flow chart area to 

edit the step. The step will be automatically added between "test begin" and "test end". 

The software allows the user to click the right mouse button and use the pop-up menu 

to delete, copy, cut or paste the steps (Figure 3-13). 

Delete: right click the mouse to get the menu "Delete" or press the < Delete > key to 

delete the currently selected step. 

Copy or cut: refers to the current selection of the step to copy or cut. 

Paste before this object: refers to pasting and inserting the current copy or cut step 

into the previous step of the current step. 

Selection of all similar objects: refers to the selection of all the same steps as the 

current step-mode in a complete test process. For example, the current selected step is 

"constant current discharge". After clicking "select all similar objects", all the "constant 

current discharge" steps will be selected in the test process. 

When the mouse clicks on any step, a red rectangular box appears around the step, 

indicating that the step is being selected. At the same time, there will be a red number in 

front of the left of the step, representing the step number in the flow chart, which is 

automatically generated by the software and can’t be edited. 
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The Loop or Decision step always contains an arrow to go to another step which can 

be set, by either enter the value or by drag the arrow.  

 

Figure 3-13 

Entity step settings 

Prime Parameters 

After adding steps to the flow chart area, you need to set the parameters for the steps 

in detail (Figure 3-14). 
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Figure 3-14 

Double-click a step to bring up the Detailed Parameters dialog box. In this interface, 

you can set the "Prime Parameters", "End Conditions", "Log Conditions", and "Safety 

Conditions" of the step. The user can arbitrarily perform "main parameter setting" under 

the premise of obeying the agreed syntax format. 

End Conditions Settings 

In the "End Conditions" edit box, click the black triangle icon to the right of the edit 

box to bring up a floating menu (Figure 3-15). 

 

Figure 3-15 
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Support for "step time", "voltage", "current", "capacity", "-DV", "charge and discharge 

cycle", "DC internal resistance", user-defined variable, "current" in the end condition Real-

time variables such as "magnification" and "coulomb efficiency" are compared for "=" (ie, 

"→"), "≥", "≤", ">", or "<" relationship.                                                                           

The end condition may be a simple single condition, or a complex condition group 

consisting of multiple conditions by "or" and "and" mixing operations. 

If you need to change or delete an end condition that has been set, click the "End 

Condition" edit box and click <Delete> to delete, then re-edit. 

 The "Step Time" item accepts a common time format in addition to accepting an 

integer second value. For example, "30:10" means 30 minutes and 10 seconds, "1:30:00" 

means 1 hour and a half, and so on. 

Here: "step time" refers to the time when the current step has been executed; "voltage" 

and "current" refer to the voltage and current values sampled in real time; "capacity" refers 

to the cumulative capacity of continuous or continuous discharge (possibly several working 

steps) "-DV" means -ΔV, which is the negative slope; "charge and discharge cycle" refers 

to the number of cycles displayed to the user in the test window of the monitoring software 

(LANDMon.exe) -- that is, the number of times the charge and discharge are converted. It 

is globally accumulated; "t1", "C1", "N1", and "N2" are custom variables. 

The software does not have any restrictions on the use of the above variants. For 

example, when charging a constant current, the "current" variable can be compared - in 

fact, even if the test equipment and the battery are normal, if the fixture is open, the actual 

output current cannot be guaranteed. Equal to the set current value - thus, in some special 

cases, this comparison is also meaningful. 

The end condition fills in nothing, the default is "TRUE". It can also be understood 

that if the user does not fill in an end condition, it is unconditionally terminated, that is, the 

end condition is always satisfied. If a "working step" includes multiple end condition 

groups, the previous condition group is checked first.                                                                                    
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Log Conditions Settings 

In the entity step of operation, the detailed parameter settings also include the Log 

Conditions (Figure 3-14). The recording condition defines the frequency of data recording 

during the test. It includes three items: "Dlt-Time", "Dlt-Voltage" and "Dlt-Current". The 

meanings are: how long the interval records a data; when the voltage changes, A data is 

recorded when the voltage is raised or lowered by how many volts; when the current 

changes, how much mA is increased or decreased when the current is recorded. 

 

Figure 3-15 

In the Log Conditions, each item has a selection mark (i.e., a check button) in front of 

it: when the selected mark is selected, the item is valid; otherwise, it is invalid, even if the 

user has entered a value in the corresponding line edit box, ignored by the software -- in 

fact, as long as the user enters the value in the edit box, the selection mark at the beginning 

of the line automatically changes to the selected state unless the user forcibly changes it. 
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The above three items are logical “OR" relationships, that is, if any one condition is 

satisfied, one point will be recorded. Among them, "Dlt-Time" item accepts a commonly 

used time format, such as "00:2:10" or "2:10", in addition to accepting an integer second 

or millisecond value, when the selected unit is seconds, which means 2 minutes and 10 

seconds. 

It is important to note that recording conditions define how to record data points, which 

should be as finely as possible in order not to lose the main features of the test. It does not 

affect the accuracy of some parameters that is calculated by the software. In real time test—

because of real-time sampling It's always in progress, it's not controlled by the user, and 

the data points that the user records are saved are only a small fraction of the many sample 

points. For example, capacity----it is the integration of real-time current value over time, 

independent of user-defined recording conditions. 

So, how do you set the specific values of each item in the recording condition? 

According to experience, usually a complete cycle has no less than 80-100 record points, 

and the curve is relatively smooth. "Time variation" can be used to ensure the minimum 

number of recorded points. Considering "voltage change" or "current change", some 

recording points are added, and the value can be taken as 1/80--1/50 of the cycle period, 

for example, 0.5C charge and discharge, one cycle is 4h (charge and discharge for 2h each), 

considering that the current in the constant voltage phase is small, and there will be a certain 

overcharge during charging (reasonable overcharge), take a cycle of 5h, count 5 ×

60=300Min., the "Dlt-Time" value can be set to 300×(1/80−-1/50)≈4--6Min.; using  

"voltage change" or "current change" to ensure the recording of feature points. The value 

can be taken as about 1% of the full scale of the device (of course, also refer to the normal 

voltage and current range of the battery under test), for example, the range is 5V, and the 

"Dlt-Voltage" can be set to 0.04 - 0.05V. Of course, the software supports users to adjust 

the values of various parameters in a wide range, and users can completely set their own 

standards according to their actual needs and experience.  
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Similar objects parameter settings 

The Landt Testing Steps editor software can simultaneously set parameters for the 

same kind of objects (IE the same working mode) in a test process. In a complicated 

charging and discharging test process, for a plurality of testing steps having the same 

working mode and working parameters, the function of simultaneously setting parameters 

eliminates the cumbersome operation of setting one step of the working step parameters. 

Save time for step editing. 

Right click on the blank area of the editing area, pop up the right-click menu item 

(Figure 3-16), click the "Select All Charging Objects" or "Select All Discharging Objects" 

menu to select the same kind of objects. 

 

Figure 3-16 

Right click on an entity working step to get a context menu (Figure 3-17). Click "Select 

All Similar Objects" to select all the similar steps in the flow chart, and then right click to 

choose "Properties". In this way two or more identical working steps can be set or modified 

at the same time. 

 

Figure 3-17 
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Non-entity step settings 

Variables 

Variables are mainly used to program very complicate tests. Custom Variables 

currently support Time Variable t1, Capacity Variable C1, and Counter Variables N1 and 

N2. Custom variants can be used in "End Conditions". Variables of each channel do not 

affect each other and are completely independent in each channel. 

Drag the “Variables” into the flow chart and double-click to get the Detailed 

Parameters window (Figure 3-18). Each Variables setting bar currently has a selection flag 

(check button). When the selected flag is selected, the corresponding Variables operation 

is valid; otherwise, the corresponding Variables will not execute if not checked. Multiple 

entries can be selected at the same time. A quick way is to use the space key: first select 

one line, press the space key, then it goes to check or uncheck the next one.  

 

Figure 3-18 

"0->t1" means reset t1 (t1=00:00:00). "0 ->N1" means reset N1(N1=0), "N1+1->N1" 

means N1 gets increased by 1, and other entries are analogous. 

Time Variables t1: The software automatically performs time accumulation by itself, 

and needs to perform "0->t1" operation first. 

Capacity Variables C1: Similar to t1, the software automatically performs capacity 

accumulation by itself, and needs to perform "0->C1" operation first. 
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Counter Variables N1/N2: No automatic operation is performed on these two variables 

by the software. The operation is completely dependent on the setting in the flow chart. 

They need to be reset in a step (N1=0 or N2=0), and run "N1+1->N1" or "N2+1->N2" 

operation in a proper position (another step). They are independent but work exactly the 

same way. 

Loop 

Loop is used to run cycling test of batteries. Parameters of the Loop step includes cycle 

number (Loop Times) and "Loop From Step". (Figure 3-19). "Loop From Step" refers to 

the step to which the test goes back. It can be set by either dragging the red arrow or 

inputting the step number in the parameter window. The software does the accumulation 

of cycle number by itself and determine if Loop Time (cycle number) is met or not. If not, 

it goes back to a previous step.  

Support 3-level nested loops. 

 

Figure 3-19 

Decision 

Decision enables the test goes a specified step if some condition is met. Parameters of 

the Decision step consist of "Goto Conditions" and "Goto Step" (Figure 3-20). The "Goto 

Conditions" setting is the same as the end condition setting. It can be time, voltage, current, 

cycle, etc. If "cycle" is chosen, it does the same job as "Loop".  
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The role of Decision is to perform jump condition judgement and jump to a specified 

step. Since the Decision is a non-entity step, and the test won’t stay in the step. If the "Goto 

Condition" is not met it will go to the next step.  

 

Figure 3-20 

Pause 

The Pause step has no parameter setting and can only add some prompt text (Figure 

3-21). Pause means that the test is suspended and held at the "step". 

The difference between Pause and Rest is that Pause step means to suspend the test. 

Pause step will not charge or discharge the battery. The test will not go to the "next step" 

by itself. Rest step can be regarded OCV test. It is either constant current charging or 

constant current charging, with current value at approximates zero. Rest can define the end 

conditions. If it meets the end conditions, the test automatically to "next step".                                                  

 

Figure 3-21 
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Comment 

"Comment" is used to take notes or input some information in the blank area next to 

the flow chart (Figure 3-22). 

 

Figure 3-22 

Safety Conditions Settings 

Double-click the "Global Configuration" in the main interface of the software, and it 

shows a parameters setting window (Figure 3-23). Among them, "Voltage Safety", 

"Current Safety", "Capacity Safety" and "Change-Trend Safety" are all safety conditions 

in the test. "Assistant Channel Safety" refers to auxiliary channels. Normally it is not 

enabled.  
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Figure 3-23 

 

"Safety Conditions" is to assure battery tests running within normal voltage/current 

ranges. It works only when something unusual happens and the cell voltage/current goes 

beyond normal range during the test. For example, unreasonable parameters are set for the 

test and there is no end condition. In some case the battery cell itself has problems. During 

the test if “Safety Conditions" is touched, the test will stop. When the abnormal condition 

is removed, the test can be resumed with “continue" function. 

Commonly used protection is voltage protection. Lithium-ion batteries seldom go 

beyond 5V. Nickel-cadmium and nickel-hydrogen battery are seldom discharged to 0.6V 

or below, nor are charged to 1.6 V or higher.  The item in "Delay Check Voltage” works 

at the beginning of some tests when the initial cell voltage is ridiculously low while charged 
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it comes into normal range. For example, some lithium cells may have the OCV of 0V 

before formation, but after an initial charge the cell voltage will come to normal.                                    

Use of Variables 

1. Time Variables t1: The software automatically performs time accumulation by itself 

since the reset operation (0->t1). 

Figure 3-24 is an example of using a time Variables t1. The test achieves a special 

feature: cell voltage is maintained between 4.0V and 4.2V for 48 hours. Here t1 is used as 

a timer. 

 

Figure 3-24 

2. Capacity Variables C1: similar to t1, the software automatically performs capacity 

accumulation during charge/discharge by itself since the reset of C1 (0->C1).  

Figure 3-25 shows an example of capacity Variables C1 that in a cycle test (500 cycles) 

the capacity for constant voltage charge must be less than 800 mAh, otherwise the test will 

terminate.   
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Figure 3-25 

3. Counter Variables N1/N2: different from t1 and C1, there is no accumulation by the 

software unless instructed. They need to be set (0->N1 or 0->N2) and in a proper step to 

run (N+1->N, N get increased by 1). Use of Variables N1/N2 is described in the next 

section “Loop”. 

Loop 

1. using a "charge and discharge cycle" to achieve a simple cycle 

The "charge and discharge cycle" refers to the number of cycles displayed to the user 

in the test window of the monitoring software (LANDMon.exe)—that is, the number of 

times the charge and discharge are converted. The user can monitor it in the "End 

Conditions" and Decision. The "charge and discharge cycle" is an internal real-time 

variable whose initialization and accumulation are automatically done by the software. 



 33 

 

Figure 3-26 

Figure 3-26 is an example of a simple 50-cycle with a "charge and discharge loop 

"Variables. 

It should be specially pointed out that: 1 The accumulation of the "charge and 

discharge cycle "Variables needs to have alternating changes of charge and discharge. If 

there is only charge or only discharge, the value of the "charge and discharge cycle" 

Variables does not change; 2 "charge and discharge cycle" The Variables is initialized only 

once when the channel is initially started (automatically by the software), and is always 

accumulated during channel operation—that is, it is Global. 
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Figure 3-27      

The example in Figure 3-27 is a misuse of the "charge and discharge cycle" Variables. 

The original purpose of the test was to perform 20 cycles with a 5 mA current followed by 

30 cycles with a 2 mA current. In fact, only 10 cycles are performed with a current of 2 

mA, because after 20 cycles with a current of 5 mA, the "charge and discharge cycle" 

Variables has been accumulated to 20, and only 10 cycles are required to reach 30 cycles. 

In this case, using the custom VariablesN1/N2 is not easy to make mistakes and is easy to 

understand (see below). 

2. using the custom Variables N1/N2 to achieve a simple loop 

The counters N1/N2 are used for counting, and their operation is completely dependent 

on user control (including clear operation and add 1 operation). Counter N2 is used in 

exactly the same way as counter N1. 
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Figure 3-28 

Figure 3-28 is an example of a loop implemented using the custom Variables N1. It 

also demonstrates the case where a custom variable is used multiple times in the same test. 

It implements this test: first charge and discharge 20 times with 5mA current. After the 

cycle, 30 cycles were followed by a 2 mA current. 

3 Use the custom Variables N1 and N2 to achieve complex nested loop 

Figure 3-29 shows an example of nested loop using custom counter the variable N1 

and N2.                  
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Figure 3-29 

In Figure 3-29, steps 4 to 12 are large loop bodies, and steps 5 to 8 are inline small 

loop bodies. It implements such a test process: firstly charging and discharging 5 cycles 

with a small current of 6 mA, and then charging and discharging one cycle with a large 

current of 10 mA, and repeating 10 times in this manner. 
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Tips 

1. Support "Undo/Redo"; Support "Copy/Paste between documents". 

2. Support selecting multiple steps and rewrite their parameters at the same time. 

3. Easily operable loop programming; Support 3-level nested loops; Support 5-level 

nested loops in cooperation with the variable N1/N2. 

4. Condition expression: text with syntax highlighting; meanwhile support the 

classic method (V5.9); And also can use auto-comparison symbol "~". 

5. Flexible multi-select by using the mouse with <shift> and <Ctrl> key; Support 

"Clone and Drag" by pressing  <Ctrl> key 

6. Support scrolling the mouse wheel forward/backward to zoom in and zoom out 

the curve. (Also supported: <Ctrl>  + ‘+’ or <Ctrl> + ‘-’  key) 
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Landt Data Processing Software (LANDdt) 

Start the software 

Double click "LANDdt" icon or select the "Open Data" in the control software 

(LANDMon), you can also start the data processing software. 

 

Figure 4-1 

As can be seen from the figure: 

a) Multiple ( test ) data files can be opened in the same window 

b) The window contains graph on the left and data on the right.  
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Software Features 

Data Analysis 

1) Analyze data in different format. This includes data entry show/hide, display cycle 

range, fold and expand the cycle data, fold and expand detailed data. 

2) Copy the data to Windows clipboard 

3) Data export 

4) Set discharge plateau 

5) Set active material parameters and cycle  

6) View test Information: view channel information and setting up information; 

7) Check test event: View other information during the test (such as power-down, 

safety alert and stop, etc.) or the user's operation (such as mandatory jump, stops) 

8) Data printing and print preview  

 

a) Graph operation 

1) Graph settings: Set the drawing for corresponding data (such as voltage - discharge 

capacity graph, Efficiency - Cyclograph etc.). 

2) Viewing graphs: including moving graph, zoom in or out, etc.  

3) Copied to the WINDOWS clipboard. 

4) Graphic axes: Setting the axis range, re-scale, grid lines and axes caption etc.  

5) Units: Setting the unit for the axis. 

6) Cycle data comparison: Put several cycling data in the same graph.  

7) Graphic printing and print preview. 
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Use of the software 

In the following windows a test data file is opened. The data area is on the right, while 

the graph is shown on the left. After right click the index header bar, a menu will pop up; 

which allows what kind of data rows to be shown in the data area. Right click in the data 

table another menu will also pop up, where there are many other selections (Figure 4-3). 

 

Figure 4-2 
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Figure 4-3 

Typically, a complete test consisted of many (charge/discharge) cycles, in which each 

cycle includes several steps (charge, rest and discharge), and each step also includes a many 

data recorded (time, voltage, current etc.). Thus, the data is divided into cycle data, step 

data and detailed recorded data. To view these data in detail, the user can just click to 

unfold and to fold the data.  

Please note that when a row of data is selected (by left click the mouse), the index 

header bar automatically changes for cycle data, step data or detailed recorded data. This 

facilitates users to copy the data they need.  

For cycle data 

 

For step data 

 

For detail recorded data 
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The data which is inconsistent with the header bar (not the same level) is displayed as 

grey.  

A) Set the cycle range to be displayed  

In the "Data Selection Browse", click the small box on the right. In the dialog box the 

cycle range can be set. If the "Data Selection Browse" is not shown in the window, make 

sure in the top menu "View">"Data Selection Pane" is checked.  

 

 

 

B) Fold/unfold the data  

The first method is to directly left click the fold icon. If the data is folded 

(corresponding to the cyclic data is not visible), left-click the "[+]" icon ", the 

corresponding data will become visible. Similarly, click on the "[-]" icon to fold the 

corresponding data. 

Users can also use the  icons to fold and unfold the data.  

 

C) Copy the data to WINDOWS Clipboard: 
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Select data: 

First fold or unfold to view the data. Click one row of the data then the header bar will 

change accordingly. Select in the header bar the columns you want to copy. The 

background of the columns will become black. Right click the mouse, select "Copy the 

data" which can be directly pasted in Excel or Origin. It should be noted that during the 

copying "What You See Is What You Get (WYGIWYS)"those data which is invisible 

(folded) is not copied.  

 

Figure 4-4 

D) Active material parameters  
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Figure 4-5 

Right click the data table and select "Active Material" the weight of the active material 

can be set. Based on it Specific Capacity (mAh/g) (Charge-SpeCap and Discharge-SpeCap 

in the header bar) can be calculated.  

For some cells it needs to discharge first before charge in a cycle, especially for anode 

materials research with a half cell (Graphite-Li, Si-Li), it can be set here whether a cycle 

starts from charge or discharge.  

 

E) View test Information. The test information can be viewed which contains the initial 

setup for the test.  

 

Figure 4-6 

F) Check test event. It’s to view test event during the test (such as power-down, safety 

issue, etc.) or the user's mandatory operations (such as mandatory jumps, stops). 
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Figure 4-7 
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Landt Calibration Tool Software (LANDCali) 

Three basic parameters of Calibration: time, current, and voltage are involved in the 

battery test systems. All the other values are calculated based on the three basic parameters. 

"Time" is defined by the computer (PC) systems, which has little to do with the test 

equipment. Thus, the basic calibration parameters only contain the current and voltage.  

There are three important values in the test system, which are used to evaluate the 

precision of the test system: the set value which is set by the user, the measured value which 

is the actual output from the device and the displayed value. Due to inevitable problems, 

the closer of the three current values, the better the precision of the test machine. Here, we 

use control inaccuracy to represent the difference between the measured value and the set 

value, measurement inaccuracy to represent the difference between the displayed value and 

the measured value. 

Assuming current control inaccuracy: 0.1% RD +0.1% FS. That is to say: 

Control inaccuracy = |set value - measured value| ≤ set value × 0.1% + current range 

of the equipment × 0.1% 

Similarly, if the current measurement: 0.1% RD +0.1% FS. That is to say: 

Measurement inaccuracy = |measured value - the display value| ≤ measured value × 

0.1% + current range of the equipment × 0.1% 

The 4 electrodes are used in the calibration. All battery test channels have four 

electrodes which contain two current output leads and two voltage measurement leads. In 

the following picture it shows the four leads. From the color and size of the alligator clips 

the leads can be identified: big clips for current output/input, little clips for voltage 

measurement, red clip connecting the positive electrode of a battery, black clip connecting 

the negative. 
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Overview 

Typically, after prolonged use of electronic instruments it may result in reduced 

accuracy. The battery test system supports accuracy correction through the online precision 

adjustment. To calibrate the test system, the user doesn’t need to open the "box". The user 

can even calibrate some channels while the other channels are still testing since all the 

channels are independent. The calibration is performed through the calibration software 

(LANDCali.exe). 

Manual calibration: a multimeter is needed.  

The precision calibration tool (LANDCali.exe) itself is an independent software. It is 

recommended that LANDMon/LANDCore is closed during the calibration, since some 

other functions may be restricted.  

 

For current calibration 

Connect the multimeter as indicated in the following figure.  

 

Figure 5-1 

Note only BIG alligator clips are used for current calibration. SMALL clips for voltage 

measurement are not involved.  

 

For Voltage calibration 
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Figure 5-2 

As shown above, all the four clips are used in the voltage calibration. Note please DO 

NOT let small clips and big clips touch (small red and big red, small black and big black), 

otherwise the calibration will be affected.   

Calibration Software Operation: 

1. Connect the device with the computer.  

Start the LANDCali software.  

 

Figure 5-3 
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Press "Connect", the LANDCali will search for devices. If connected the box 

and channel information will display. Click "Setup" > "Calibration Mode", select 

"Manual". 

2. Select the channel to calibrate (1#: I--, V--,I2--). 

3. Select current or voltage to calibrate. 

4. Parameters setup. Press "Setup" and select "Calibration Setup".  

 

  

Figure 5-4 

For both current calibration and voltage calibration, two reference points are needed. 

Generally one point is chosen between 10%~20% and the other between 70%~90%. The 

two points should not be too close or near the maximum.  

For voltage calibration a resistance is used. The value of the resistance can be obtained 

by click "Prompt resistance Range" 

5. Click "Advanced" and press "Read". The values of k1 and k2 should be very close 

to 2097152. If either is 20% higher or less than that value, Press "Init-Value" and 

Write.  

6. Start Calibration.  
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Change the Box No. of the device 

In the Advanced setup of the LANDCali, the Box No. can be revised. If you received 

two devices with the same Box No, one has to change the Box No. The Current and Voltage 

Ranges are determined during the manufacturing and are not supposed to be changed. 

First open the device which needs to change the Box No., but other devices need close 

and our software need exit. Then open the LANDCali.exe software, find "Unit From" and 

press "Connect" (see Figure 5-5), When test result is coming out, press "Advanced "(see 

Figure 5-6), then the Box No. Of the device can be changed. Once the Box No. is changed, 

please press "Write"(see Figure 5-6). 

 

Figure 5-5 
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Figure5-6 

Notes: The Current and Voltage Ranges are determined during the manufacturing and 

are not supposed to be changed. 


